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[bookmark: _Toc51414303]Purpose
Activate the integration of SAP Fieldglass with SAP S/4HANA to support, automate, and extend SAP S/4HANA contingent labor and statement of work hiring and management processes.
You benefit from this integration by digitizing the processing of invoices. You can automate invoice processing in SAP S/4HANA and ensure data integrity. Maintain consistency as you replicate your master data (such as cost centers, WBS elements, G/L Accounts, plants, suppliers, company codes, and purchasing organizations) from SAP S/4HANA to SAP Fieldglass.
This document provides a detailed procedure for testing this scope item after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.
[bookmark: unique_2][bookmark: _Toc51414304]Prerequisites
This section summarizes all the prerequisites for conducting the test in terms of systems, users, master data, organizational data, other test data and business conditions.
[bookmark: unique_3][bookmark: _Toc51414305]Additional Manual Configuration
Before you can test this scope item, you must have completed the additional configuration steps that are described in the Set-Up Instructions for this scope item. These configuration steps are specific for your implementation and include mandatory settings that are not delivered by SAP and must be created by you. For more information, refer to the Set-Up Instructions for this scope item on SAP Best Practices Explorer (https://rapid.sap.com/bp/#/browse/scopeitems/<enter the scope item ID>).
[bookmark: unique_4][bookmark: _Toc51414306]System Access
	System
	Details

	SAP Fieldglass
	Accessible via the Fieldglass System. Your system administrator provides you with the URL to access the various apps assigned to your role.

	SAP S/4HANA Fiori Launchpad
	Accessible via the SAP Fiori Launchpad. Your system administrator provides you with the URL to access the various apps assigned to your role.


[bookmark: unique_5][bookmark: _Toc51414307]Roles
Assign the following business roles to your individual test users in SAP S/4HANA:
	Name (Role)
	ID (Role)
	Description (Space)
	ID (Space)
	Log On

	Accounts Payable Accountant
	SAP_BR_AP_ACCOUNTANT
	Accounts Payable
	SAP_BR_AP_ACCOUNTANT
	

	Administrator
	SAP_BR_ADMINISTRATOR
	Administration
	SAP_BR_ADMINISTRATOR
	


Use the following standard test users to run test procedures in SAP Fieldglass:
	Name
	Description
	Log On

	Buyer/Administrator
	This user has administrator rights, can create Job Postings, view Job Seekers, and hire Job Seekers to create Work Orders.
	

	Supplier
	This user can manage the sites they can service, view Job Postings and is responsible for submitting Job Seekers and accepting Work Orders.
	

	Distributor
	This user is responsible for distributing Job Posting to specific suppliers.
	

	Approver
	This user is authorized to be notified when SAP Fieldglass Work Items are created and approve these submitted items, including Job Postings, Work Orders, Time/Expense Sheets, Invoices, etc.
	

	Program Office (PMO)
	This user can manage Onboarding Task (ex: background check) and activate worker.
	


[bookmark: unique_6][bookmark: _Toc51414308]Master Data, Organizational Data, and Other Data
SAP Best Practices Standard Values based on new global template will be used once available. In the table you still see the master data used for the current baseline.
Essential master and organizational data was created in your SAP S/4HANA system in the implementation phase, such as the data that reflects the organizational structure of your company and master data that suits its operational focus, for example, master data for materials, vendors, and customers.
This master data usually consists of standardized SAP Best Practices default values, and enables you to go through the process steps of this scope item.
Additional Master Data (Default Values)
You can test the scope item with other SAP Best Practices default values that have the same characteristics.
Check your SAP system to find out which other material master data exists.
Using Your Own Master Data
You can also use customized values for any material or organizational data for which you have created master data. For more information about creating master data, see the Master Data Procedures documentation.
Use the following master data in the process steps described in this document:
	SAP Fieldglass Object
	SAP S/4HANA Object
	Code
	Name

	Legal Entity
	Company Code
	<Company Code>, for example, 1010 (DE)
	For example, Company Code 1010 (DE)

	Business Unit
	Purchasing Organization
	<Purchasing Organization>, for exmaple, 1010 (DE)
	For example, Purch.Org.1010 (DE)

	Site
	Plant
	<Plant>, for example, 1010 (DE)
	For example, Plant 1 DE (DE)

	Cost Center
	Cost Center
Internal Order:10000 R and D Internal Order
WBS Element: PFCProject1
WBS Element:PFCProject11
	Cost Center, for example, A0000010101101 (DE)
	For example, Finacials (DE) (DE)

	Supplier
	Vendor
	<Vendor>, for example, 10300080 (DE)
	For example, DE Supplier (Fieldglass Network) (DE)

	General Ledger Account
	General Ledger Account
	65100000
	Purchased Services

	Task Code
	
	
	TC

	Invoice Adjustment
	
	
	V1


For more information on creating master data objects, see the following Master Data Scripts (MDS)
Table 1: Master Data Script Reference
	MDS
	Description

	BNF
	Create Product Master of Type "Trading Good"

	BND
	Create Customer Master


[bookmark: unique_7][bookmark: _Toc51414309]Overview Table
The scope of the section Contingent Labor consists of several process steps provided in the table below.
If your system administrator has enabled spaces and pages on the SAP Fiori launchpad, the homepage will only contain the essential apps for performing the typical tasks of a business role.
You can find all other apps not included on the homepage using the search bar.
If you want to personalize the homepage and include the hidden apps, navigate to your user profile and choose Settings > App Finder .
	Process Step
	Business Role
	Transaction/App Name
	Expected Results

	SAP Fieldglass

	Create and Submit Job Posting  [page ] 22
	Buyer/Administrator
	
	The job posting is created, submitted, and routed to the status Pending Approval.

	Approve Job Posting  [page ] 25
	Approver
	
	The job posting is approved, and routed to the status Pending Distribution.

	Distribute Job Posting  [page ] 26
	Distributor
	
	The job posting is distributed to a specific supplier, who receives a work item to respond to.

	Submit Job Seeker to Job Posting  [page ] 27
	Supplier
	
	A job seeker is submitted by the supplier, and the job posting is routed to the next step.

	Shortlist Job Seeker  [page ] 29
	Program Office (PMO) User
	
	The status of the job seeker changes to Shortlisted. The job seeker is ready to be interviewed and eventually hired.

	Hire Job Seeker  [page ] 30
	Buyer/Administrator
	
	The job seeker, who was shortlisted by the Program Office (PMO) User, is hired and a work order is created.

	Complete and Submit Work Order  [page ] 31
	Buyer/Administrator
	
	The work order is completed, submitted, and routed to the status Pending Approval.

	Approve Work Order  [page ] 33
	Approver
	
	The work order is approved and needs to be accepted by the supplier.

	Accept Work Order  [page ] 34
	Supplier
	
	The work order is accepted by the supplier, and needs to be activated by the Program Office (PMO) user, who receives a work item to respond to.

	Activate Work Order  [page ] 35
	Program Office (PMO) User
	
	The work order is activated, and a registration email is sent to the worker’s email address.

	Register Worker  [page ] 36
	Worker
	
	The worker is registered in the SAP Fieldglass system.

	Submit Time Sheet  [page ] 37
	Worker
	
	The time sheet is submitted by the worker, and routed to the status Pending Approval.

	Approve Time Sheet  [page ] 39
	Buyer/Administrator
	
	The time sheet is approved. An invoice is automatically generated, and needs to be approved.

	Approve Invoice  [page ] 40
	Approver
	
	The invoice is approved.

	SAP S/4HANA back-end system

	Trigger Transfer of Updated Invoice Status from SAP Fieldglass to SAP S/4HANA  [page ] 41
	Administrator
	SE38
	Trigger the transfer of the updated invoice status from SAP Fieldglass to SAP S/4HANA.

	SAP Fieldglass

	Check Updated Invoice Status  [page ] 44
	Buyer/Administrator
	
	The status of the invoice in SAP Fieldglass is changed to Payment Pending.

	SAP S/4HANA Fiori launchpad

	Pay Invoice in SAP S/4HANA  [page ] 42
	Accounts Payable Accountant
	Post Outgoing Payments (F1612)
	The payment for the invoice transferred from SAP Fieldglass to SAP S/4HANA is posted.

	SAP Fieldglass

	Check Updated Invoice Status  [page ] 44
	Buyer/Administrator
	
	The status of the invoice in SAP Fieldglass is changed to Paid.


The scope of the section Statement of Work consists of several process steps provided in the table below.
	Process Step
	Business Role
	Transaction/App Name
	Expected Results

	SAP Fieldglass

	Manage Supplier Classification  [page ] 46
	Buyer/Administrator
	
	A supplier classification is created.

	Associate Classification to Supplier  [page ] 47
	Buyer/Administrator
	
	The newly added classification is associated to a supplier.

	Associate Business Units to SOW Template  [page ] 48
	Buyer/Administrator
	
	The desired business unit is associated to the SOW template to be used.

	Associate Classification to SOW Template  [page ] 49
	Buyer/Administrator
	
	The newly added classification is associated to the SOW template to be used.

	Create Statement of Work  [page ] 50
	Buyer/Administrator
	
	A statement of work is created.

	Approve Statement of Work  [page ] 53
	Approver
	
	The statement of work is approved, and routed to the step Pending Response.

	Accept Statement of Work  [page ] 54
	Supplier
	
	The statement of work is accepted by the supplier.

	Mark Work Item as Complete  [page ] 55
	Supplier
	
	The work item is marked as complete, and needs to be approved by Buyer/Administrator.

	Approve Transaction  [page ] 56
	Buyer/Administrator
	
	The completed transaction is approved, and is available to be invoiced.

	Create and Submit SOW Invoice  [page ] 57
	Supplier
	
	A SOW invoice is created and submitted for the approved transaction.

	Approve SOW Invoice  [page ] 59
	Approver
	
	Invoice is approved.

	SAP S/4HANA back-end system

	Trigger Transfer of Updated Invoice Status from SAP Fieldglass to SAP S/4HANA  [page ] 60
	Administrator
	SE38
	Trigger the transfer of the updated invoice status from SAP Fieldglass to SAP S/4HANA.

	SAP Fieldglass

	Check Updated Invoice Status  [page ] 44
	Buyer/Administrator
	
	The status of the invoice in SAP Fieldglass is changed to Payment Pending.

	SAP S/4HANA Fiori launchpad

	Pay Invoice in SAP S/4HANA  [page ] 61
	Accounts Payable Accountant
	Post Outgoing Payments (F1612)
	The payment for the invoice transferred from SAP Fieldglass to SAP S/4HANA is posted.

	SAP Fieldglass

	Check Updated Invoice Status  [page ] 63
	Buyer/Administrator
	
	The status of the invoice in SAP Fieldglass is changed to Paid.


[bookmark: unique_39][bookmark: _Toc51414310]Test Procedures
This section describes test procedures for each process step that belongs to this scope item.
[bookmark: d2e268][bookmark: _Toc51414311]Replicate Master Data from SAP S/4HANA to SAP Fieldglass
[bookmark: unique_40][bookmark: _Toc51414312]Replicate Company Code
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate company code from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose AR_CCODE.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the Company Code: 1010.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	


[bookmark: unique_41][bookmark: _Toc51414313]Replicate General Ledger Account
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate general ledger account from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose AR_GLACC.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the General Ledger Account: 65100000.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	


[bookmark: unique_42][bookmark: _Toc51414314]Replicate Cost Center
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate cost center from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose AR_CC.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the following data:
1. Controlling Area: A000
· Cost Center: 10101101
Choose Save.
	
	

	6
	Select Replication Mode
	In the Replication Mode field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	



[bookmark: unique_43][bookmark: _Toc51414315]Replicate Purchasing Organization
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate purchasing organization from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose LMDR_PORG.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the Purch. Organization: 1010.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	



[bookmark: unique_44][bookmark: _Toc51414316]Replicate Plant
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate plant from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose LMDR_PLANT.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the Plant: 1010.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	



[bookmark: unique_45][bookmark: _Toc51414317]Replicate Business Partner
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate business partner from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose 986_3.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the Business Partner: 10300080.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
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Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate WBS element from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose FG_WBS_ELE.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the WBS Element: PFCProject1.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Model field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
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Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this process, you replicate sales order from SAP S/4HANA to SAP Fieldglass.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system.
	
	

	2
	Open Transaction
	Open transaction DRFOUT.
	
	

	3
	Choose Replication Model
	In the Replication Model field, choose FIELDGLASS.
	
	

	4
	Choose Outbound Implementation
	In the Outbound Implementation field, choose FG_SO.
	
	

	5
	Define Filter Criteria
	On the Manual Replication Filter Criteria tab, enter the Sales Order: 100000.
Choose Save.
	
	

	6
	Select Replication Model
	In the Replication Mode field, select Manual.
	
	

	7
	Execute Replication
	Choose Execute.
	The Displays logs screen is displayed.
If the replication succeeds, the appl.log contains an entry with an SAP Fieldglass transaction ID.
	


[bookmark: unique_48][bookmark: _Toc51414320]Contingent Labor
This section describes test procedures for each process step that belongs to the case Service Procurement for Work Order.
[bookmark: unique_8][bookmark: _Toc51414321]Create and Submit Job Posting
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to create a job posting by selecting a well-defined job posting template.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as a Buyer.
	The Home screen is displayed.
	

	2
	Access Job Posting Creation
	From the Create menu, choose Job Posting for Worker.
	The Create Job Posting screen is displayed.
	

	3
	Select a Job Posting Owner
	Select the correct job posting owner.
Note The job posting may be routed for approval based on the owner selected.
	
	

	4
	Search for Job Posting Template
	Search for a specific template or an existing job posting. Enter or select the desired information in the search fields, and choose Filter to narrow the list.
Enter the following data:
1. Billing Currency: (for example) EUR
· Source: Job Posting Templates
	A list of possible templates is displayed.
	

	5
	Select Job Posting Template
	Choose the Title of the desired template.
1. Title: Billing Analyst
	The Setup screen is displayed.
	

	6
	Enter Start Date and End Date
	Enter Start Date and End Date for the job posting (for example July 1st 2016 – September 30th 2016).
	
	

	7
	Enter Number of Positions
	Enter the Number of Positions as 1.
	
	

	8
	Select Travel Requirement
	In the Is travel required for position? field, select the value No.
	
	

	9
	Select Legal Entity, Site, and Business
	Select the desired Legal Entity, Site, and Business Unit. Enter the following data:
1. Legal Entity: (for example) Company Code 1010 (DE)
· Site(Plant): (for example) Plant 1 (DE)
· Business Unit (Purch. Org.): (for example) Purch.Org.1010 (DE)
Note Locations are associated with specific sites. The correct value is automatically displayed in the Location field. There’s no need to change it.
	
	

	10
	Select Cost Center and General Ledger Account
	Select Cost Center and General Ledger Account from the dropdown list.
1. Cost Center: (for example) A0000010101101 Financials (DE)
· General Ledger Accunt: (for example) 65100000
Note If the expected cost center isn’t on the list, choose the Add or remove Cost Centers link. Check the option Unused, select the desired cost center, and choose Add Selected. To return to the setup screen, choose Update.
	
	

	11
	Continue Job Posting Creation
	Choose Continue.
Note If Continue doesn’t exist, choose Submit, and navigate to the Job Posting Details screen. To recontinue the job posting creation, choose Edit.
	The Augment screen is displayed.
	

	12
	Enter Posting Information (Optional)
	If desired, enter Posting Information.
The Buyer reference field is optional. You can enter information, such as an internal reference number, that can then be used to search for this job posting.
Based on company configuration, you may be required to enter a Coordinator. The coordinator is typically a member of the program office, who is responsible for assisting with this job posting.
	
	

	13
	Enter Qualifications
	Skip this field, and leave it as No Qualifications specified.
Note To enter or update desired qualifications, use the Add or remove Qualifications link. Suppliers rate job seekers on the listed qualifications.
	
	

	14
	Enter Time and Expense Sheet Settings
	Enter or update Time Sheet; Expense Sheet Settings. Depending on the job posting template configuration, default values are displayed. There’s no need to change it.
1. Time Sheet Type: Standard
· Hours per Day: 8
· Hours per Week: 40
	
	

	15
	Enter Accounting Information
	Enter or update Accounting information as required. Depending on the job posting template configuration, default values are displayed. There’s no need to change it.
	
	

	16
	Enter Distribution Information
	Select the correct Distributor from the dropdown list.
Based on the job posting template configuration, the Distribution list should have been automatically assigned.
The Maximum Submissions per Supplier field is optional.
The Supplier Respond By Date field is also optional. If populated, it triggers a notification to the job posting owner, that the supplier should have responded by this date.
	
	

	17
	Add Attachments
	Skip this field, leave it as No Attachments Defined.
Note If desired, use the Add Attachments link, to add an attachment such as job description to the job posting.
	
	

	18
	Enter Rules
	Enter or update the Rules. Depending on the company configuration and job posting template, default values are displayed.
In the Job Seeker Rate/Salary can exceed Requested Rate/Salary field, select No.
For both job posting and work order, the bill rate and salary can always be lowered but can only be increased, if the rule Job Seeker Rate / Salary can exceed Requested Rate / Salary is selected.
If you select No, the supplier wouldn’t be able to submit a job seeker with a bill rate or salary exceeding the requested bill rate or salary.
Choose Continue.
	The Review and Submit screen is displayed.
	

	19
	Submit Job Posting
	On the Review and Submit screen, review the details, and apply changes if necessary.
Note To save the job posting as a draft, choose Complete Later. You can return to it at a later time for review, completion, and submittal.
When all data has been reviewed, choose Submit.
	The job posting is saved, submitted, and routed to the next step Pending Approval in the workflow.
Note The job posting is assigned a unique ID, which is displayed at the top of the screen, above the title.
	


[bookmark: unique_9][bookmark: _Toc51414322]Approve Job Posting
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to review the job posting for accuracy, make edits if necessary, and approve the job posting.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Approver.
	Job postings that require review and approval appear in your Work Items menu.
	

	2
	Access Work Item
	From the Work Items menu, select Approve in the Job Posting section.
	
	

	3
	Approve Job Posting
	Choose the ID of the posting you created, and select Approve.
Tip You can also access the job postings by selecting Job Posting from the View menu.
	The job posting is submitted, and routed to the next step Pending Distribution in the workflow.
	


[bookmark: unique_10][bookmark: _Toc51414323]Distribute Job Posting
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to distribute the job posting to suppliers based on their customer-specific distribution rules.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Distributor.
	
	

	2
	Access Job Posting
	To access the job postings, select Job Posting from the View menu.
To view detailed information about the job posting, choose the ID of the job posting desired.
	
	

	3
	Preparing Job Posting Distribution
	Choose Distribute.
	The Distribute Job Posting dialog box is displayed.
	

	4
	Select Suppliers
	In the Distribute Job Posting dialog box, select the checkbox next to the desired supplier for the job posting.
Note The list of suppliers displayed varies based on the distribution list associated with the job posting. To view the suppliers in a different distribution list, select the desired distribution list in the Distribution List field.
	
	

	5
	Distribute Job Posting
	In the Distribute Job Posting, dialog box, choose Distribute.
	The job posting is routed to the next step Supplier submits Job Seeker in the workflow.
The suppliers receive a work item to respond to the posting. The Job Posting Distribution tab reflects the distribution information.
	


[bookmark: unique_11][bookmark: _Toc51414324]Submit Job Seeker to Job Posting
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to submit a job seeker to a job posting.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as a Supplier.
	
	

	2
	Access and Review Job Posting
	From the View menu, select Job Posting in the Contingent Labor section.
Choose the ID of the job posting desired.
	
	

	3
	Submit New Job Seeker
	Choose Submit New.
	The Setup screen is displayed.
	

	4
	Complete Required Details
	Enter the mandatory data in the Details field, including First Name, Last Name, Security ID, and Available Date.
To attach a Resume or a CV, choose Attach.
Note The Security ID element has to match the format FFMMDDZZZZ, which means: FF/First two letters of worker's name, MM/Month (of birthday – The value can be made up.), DD/Day (of birth – The value can be made up.), ZZZZ/Year (of birth – The value can be made up.).
Choose Continue.
	The Rates screen is displayed.
	

	5
	Enter Rate
	Enter a Pay Rate (for example: 20), and if desired, a Markup.
To view the Final Bill Rate, choose Calculate.
Choose Continue.
	The Review and Submit screen is displayed.
	

	6
	Submit Job Seeker To Job Posting
	On the Review and Submit screen, review the details, and apply changes, if necessary.
Note To save the submission of the job seeker to the job posting as a draft, choose Complete Later. You can return to it at a later time for review, completion, and submittal.
When all data has been reviewed, choose Submit.
	The job posting is routed to the next step Requestor reviews Job Seekers in the workflow.
Tip To view the job seeker submitted, choose the Job Seekers tab.
	


[bookmark: unique_12][bookmark: _Toc51414325]Shortlist Job Seeker
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to shortlist the job seekers submitted to the job posting.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Program Office (PMO).
	
	

	2
	Access Job Posting
	From the View menu, select Job Posting in the Contingent Labor section.
Choose the ID of the job posting desired.
	The job posting screen is displayed.
	

	3
	View Job Seekers
	To view the job seekers submitted to the job posting, choose the Job Seekers tab.
	
	

	4
	Shortlist a Job Seeker
	Select the checkbox next to the desired job seeker, and choose Shortlist.
	The status of this job seeker is changed to Shortlisted, and qualifies the job seeker to be interviewed and hired.
	


[bookmark: unique_13][bookmark: _Toc51414326]Hire Job Seeker
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to hire a job seeker shortlisted by Program Office (PMO).
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Job Posting
	From the View menu, select Job Posting in the Contingent Labor section.
Choose the ID of the job posting desired.
	The job posting screen is displayed.
	

	3
	View Job Seekers
	To view the job seekers submitted to the job posting, choose the Job Seekers tab.
	
	

	4
	Hire Job Seeker
	Select the checkbox of a job seeker, and choose Hire.
	The Create Work Order screen is displayed and lists the terms requested on the original job posting.
	


[bookmark: unique_14][bookmark: _Toc51414327]Complete and Submit Work Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to complete and submit a work order to finalize the terms of the position.
Prerequisites
To complete and submit a work order, you need to hire a job seeker first. For more information, see Hire Job Seeker  [page ] 30.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Complete Work Order
	On the Create Work Order screen, review the data shown, and enter any additional data, if required:
1. Goods Receipt Is Expected: Yes
· Invoice Is Goods Receipt Based: Yes
· Item Category: E
· Material Group: YBMM00
· Product type: 2
· Purchase Group: 001
Choose Continue.
Note If the warning message Job Seeker is a Possible Match to one or more Master Worker Records is displayed, select Create new Master Worker Record, and choose Continue.
	The Review and Submit screen is displayed.
	

	2
	Submit Work Order
	On the Review and Submit screen, review the details, and apply changes if necessary.
Note To save the submission of the job seeker to the job posting as a draft, choose Complete Later. You can return to it at a later time for review, completion, and submittal.
When all data has been reviewed, choose Submit.
	The job posting is routed to the next step Pending Approval in the workflow.
Note The work order is assigned a unique ID, which is displayed at the top of the screen, above the title.
	


[bookmark: unique_15][bookmark: _Toc51414328]Approve Work Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to approve the work order.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Approver.
	Work Orders that require review and approval appear in your Work Items menu.
	

	2
	Access Work Item
	From the Work Items menu, select Approve in the Work Order section.
	
	

	3
	Approve Work Order
	Choose the ID of the work order you submitted, and select Approve.
Tip You can also access the work orders by selecting Work Order from the View menu.
	The work order is approved, and routed to the next step Accept in the workflow, waiting for the supplier to accept the work order.
	


[bookmark: unique_16][bookmark: _Toc51414329]Accept Work Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to accept the work order.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Supplier.
	
	

	2
	Access Work Order
	From the View menu, select Work Order in the Worker section.
Choose the ID of the work order desired.
	The Work Order screen is displayed.
	

	3
	Accept Work Order
	Choose Accept.
	The Accept Work Order screen is displayed.
	

	4
	Complete Posting Information
	Complete the fields Worker Email and Auto Invoice Type. The invitation for the worker to register in SAP Fieldglass is sent to this email address.
1. Auto Invoice Type: Both
	
	

	5
	Complete Adjustments
	In the Adjustment Type field, choose V1 (Invoice) from the dropdown list.
Choose Continue.
	The Review and Submit page displays.
	

	6
	Finalize Work Order Acceptance
	Verify the work order details, and choose Accept.
	The work order is accepted, and routed to the next step Activate (by Buyer). A notification is sent to the Program Office (PMO) to activate the work order.
	


[bookmark: unique_17][bookmark: _Toc51414330]Activate Work Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to verify the completed activity requirements and activate the work order.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Program Office (PMO).
	
	

	2
	Access Work Order
	From the View menu, select Work Order in the Worker section.
Choose the ID of the work order desired.
	The work order screen is displayed.
	

	3
	Activate Work Order
	Choose Activate.
	The Activate Work Order dialog box is displayed.
	

	4
	Confirm Activation
	In the Activate Work Order dialog box, choose OK.
	The work order is activated.
A registration email is sent to the worker's email address.
Note The registration email is time sensitive, and expires after 21 days. If the registration code expires or the worker has misplaced the email, you can send the worker a new email. Choose Actions, and select Resend Invitation.
	


[bookmark: unique_18][bookmark: _Toc51414331]Register Worker
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to create your account in SAP Fieldglass after receiving a registration invite.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Check Registration Invite
	Check your email inbox for the item Invitation to join the SAP Fieldglass system. To navigate to the registration site, choose the link Create Your Account in the invitation email.
	The SAP Fieldglass Create Your Account screen is displayed.
	

	2
	Complete Basic Information
	Enter the worker's Security ID, identical to what the supplier has entered when submitting this worker.
	
	

	3
	Complete Login Details
	Enter the mandatory information in the Login Details field, including Desired Username and Password.
	
	

	4
	Complete Password Recovery
	Choose one question from the Secret Question dropdown list, and enter an Answer to Secret Question, with which you can recover your username and password in case you lost your logon information.
	
	

	5
	Sign In
	To complete the registration, choose Sign In.
	The worker's username is displayed on the Welcome screen.
	


[bookmark: unique_19][bookmark: _Toc51414332]Submit Time Sheet
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to complete a draft time sheet and submit it.
Prerequisites
Note The worker needs to be assigned to a task code before entering the time sheet.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system with the worker account you created in Register Worker  [page ] 36.
	
	

	2
	Access Time Sheet
	In the Work Items to Act Upon section, select the range of dates, for which you want to create a time sheet, and choose Complete Time Sheet.
	The Enter Time Sheet screen is displayed.
	

	3
	Complete Timesheet
	Enter hours in the Time Worked field.
Note If the cost center defined in the job posting is associated with several task codes, there are multiple lines available to record your working hours. In this case, just enter hours into the line below the desired task code.
	
	

	4
	Submit Time Sheet
	Choose Submit.
Note If the Submit Time Sheet? dialog box is displayed, choose OK.
	The time sheet submitted is routed to the next step Pending Approval in the workflow.
Note In case no approval group is defined for the time sheet, an invoice is automatically generated. Then the next process is skipped.
	


[bookmark: unique_20][bookmark: _Toc51414333]Approve Time Sheet
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to complete a draft time sheet, and submit it.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer.
	
	

	2
	Access Work Item
	From the View menu, choose the Work Items link.
	The Your Work Items screen is displayed.
	

	3
	Locate Time Sheet
	From the Action dropdown list, choose Approve in the Time Sheet section.
To choose a specific time sheet, select the respective checkbox, and choose Approve.
	The Approve Time Sheet dialog box is displayed.
	

	4
	Approve Time Sheet
	In the Approve Time Sheet dialog box, if desired, enter comments, and choose Approve.
	An invoice is automatically generated, and waiting for approval.
Note In case no approval group is defined for the invoice, the invoice is automatically approved. Then the next process is skipped.
	


[bookmark: unique_21][bookmark: _Toc51414334]Approve Invoice
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to approve the invoice generated from the submitted and approved timesheet.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Approver.
	Invoices that require review and approval are displayed in the My Work Items area.
	

	2
	Access Invoice
	In the My Work Items area, select Approve in the Invoice section.
	
	

	3
	Choose Invoice
	Choose the ID of the invoice desired, and select Approve.
	The Approve Invoice dialog box is displayed.
	

	4
	Approve Invoice
	In the Approve Invoice dialog box, choose Approve.
	An invoice request message is sent from the SAP Fieldglass system to the SAP S/4HANA system.
	


[bookmark: unique_22][bookmark: _Toc51414335]Trigger Transfer of Updated Invoice Status from SAP Fieldglass to SAP S/4HANA
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to trigger the transfer of the updated invoice status from SAP Fieldglass to SAP S/4HANA.
Note If the transfer is already triggered, you can skip this procedure.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system as Administrator.
	
	

	2
	Access ABAP Editor
	Go to transaction SE38, and navigate to the ABAP Editor: Initial Screen.
	
	

	3
	Choose Program
	In the Program field, enter the value ARBFND_FG_FETCH_CXML_MESSAGES.
	
	

	4
	Run the Program
	To run the program, choose Execute (F8).
	The Fetch cXML Messages from SAP Fieldglass screen is displayed.
	

	5
	Show Log Information
	Choose Execute (F8).
	The Display logs screen is displayed.
The log information with the External ID: InvoiceDetailRequest is displayed.
Note This call gives back the client transaction IDs. To start a second call, and to download the corresponding invoice with the ID of the transferred transaction, repeat step 2 to step 5.
	


[bookmark: unique_24][bookmark: _Toc51414336]Pay Invoice in SAP S/4HANA
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to post outgoing payment for the invoice transferred from SAP Fieldglass to SAP S/4HANA.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fiori launchpad as Accounts Payable Accountant.
	The SAP Fiori launchpad is displayed.
	

	2
	Access App
	Open the Post Outgoing Payments (F1612) app.
	The Post Outgoing Payments screen is displayed.
	

	3
	Enter Payment Data
	In the General Information section, enter the following data:
1. Company Code: <Company Code> (for example) 1010 (DE)
· Posting Date: <today's date>
· Journal Entry Date: <today's date>
· Value Date: <today's date>
· Journal Entry Type: KZ
In the Bank Data section, enter the following data:
1. House Bank/Account: <House Bank> (for example) DEBK1/DEAC1 (DE)
· G/L Account: 11001000
· Amount: <amount to pay on existing invoice>
In the Open Item Selection section, enter the following data:
1. Account Type: Supplier
· Account ID: 10300080
Choose Show Items.
	In the Open Items/Standard section, a list of open items is displayed.
	

	4
	Select Item
	To select the the retrieved invoice to pay, choose Clear.
	The invoice to pay is transferred to the Items to the Cleared (Standard) section.
	

	5
	Post Item
	Choose Post.
	The system message Journal entry xxxxxxxxxx was successfully posted in company code 1010 is displayed.
	

	6
	Confirm
	To confirm the Information dialog box, choose OK.
	
	

	7
	Navigate Back
	Choose Back.
	The system message Journal entry has already been posted. You can now post a new payment. is displayed.
	

	8
	Dismiss Message
	To dismiss the message, choose OK.
	
	


[bookmark: unique_23][bookmark: _Toc51414337]Check Updated Invoice Status
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to check the updated invoice status in SAP Fieldglass.
Context
An invoice can have different statuses. The following statuses for an invoice can be displayed in SAP Fieldglass:
1. Approval Paused
· Approved
· Consolidated
· Paid
· Payment Pending
· Payment Review
· Pending Approval
· Pending Consolidation
· Rejected
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Invoice and Display Updated Invoice Status
	From the View menu, select Invoice in the Payments section.
Choose the ID of the invoice desired.
	In the Status column, the updated status of the invoice is displayed.
	


[bookmark: unique_49][bookmark: _Toc51414338]Statement of Work (SOW)
This section describes test procedures for each process step that belongs to the case Statement of Work.
[bookmark: unique_25][bookmark: _Toc51414339]Manage Supplier Classification
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In SAP Fieldglass, classifications are used to organize Statement of Work (SOW) templates and the suppliers that provide services. Before an SOW can be created, a classification must be selected. When creating an SOW, only the suppliers and SOW templates that are associated to the selected classification will be available.
Purpose
This procedure describes, how to create a new classification.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Admin Configuration
	Choose  at the top right corner of the screen.
	The Admin Configuration screen is displayed.
	

	3
	Access Classification List
	In the Configuration section, choose Classification.
	The Classifications List screen is displayed.
	

	4
	Create Classification
	Choose New. Enter the required data, and choose Add.
	
	


[bookmark: unique_26][bookmark: _Toc51414340]Associate Classification to Supplier
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to associate the newly added classification to a supplier.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Admin Configuration
	Choose  at the top-right corner of the screen.
	The Admin Configuration screen is displayed.
	

	3
	Access Classification List
	In the Configuration section, choose Classification.
	The Classifications List screen is displayed.
	

	4
	Select Classification
	On the Classification List screen, select a classification.
	A detailed overview of the selected classification is displayed.
	

	5
	Associate Supplier
	To associate suppliers to the selected classification, choose Suppliers > Add .
	The Associate Suppliers to Classification dialog box is displayed.
	

	6
	Continue Association of Suppliers
	In the Associate Suppliers to Classification dialog box, select supplier Name: 10300080.
Choose Add.
	The classification is associated to a supplier.
	


[bookmark: unique_27][bookmark: _Toc51414341]Associate Business Units to SOW Template
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to associate a business unit to a statement of work (SOW) template.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Admin Configuration
	Choose  at the top-right corner of the screen.
	The Admin Configuration screen is displayed.
	

	3
	Access SOW Template List
	In the Services section, choose SOW Template.
	The SOW Template List screen is displayed.
	

	4
	Select SOW Template
	On the SOW Template List screen, select a SOW template, for example Generic Use SOW Template.
	A detailed overview of the selected SOW template is displayed.
	

	5
	Associate Business Unit
	To associate business units to the selected SOW template, choose Business Units > Add .
	The Associate Business Units to SOW Template dialog box is displayed.
	

	6
	Continue Association of Business Units
	In the Associate Business Units to SOW Template dialog box, select business unit 1010.
Choose Add.
	The SOW template is associated to a business unit.
	


[bookmark: unique_28][bookmark: _Toc51414342]Associate Classification to SOW Template
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to associate a classification to a statement of work (SOW) template.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Admin Configuration
	Choose  at the top-right corner of the screen.
	The Admin Configuration screen is displayed.
	

	3
	Access SOW Template List
	In the Services section, choose SOW Template.
	The SOW Template List screen is displayed.
	

	4
	Select SOW Template
	On the SOW Template List screen, select a SOW template, for example Generic Use SOW Template.
	A detailed overview of the selected SOW template is displayed.
	

	5
	Associate Classification
	To associate a classification to the selected SOW template, choose Classification > Add .
	The Associate Classification to SOW Template dialog box is displayed.
	

	6
	Continue Association of Classification
	In the Associate Classification to SOW Template dialog box, select the classification, which you added in section Associate Classification to Supplier  [page ] 47.
Choose Add.
	The SOW template is associated to a classification.
	


[bookmark: unique_29][bookmark: _Toc51414343]Create Statement of Work
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to create a statement of work (SOW) by selecting a well-defined SOW template.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access SOW Creation
	From the Create menu, choose the Statement of Work link.
	The Let's Get Started ... screen is displayed.
	

	3
	Select Classification of Statement of Work
	In the Let's Get Started ... screen, select a classification of statement of work from the dropdown list, and choose Continue.
	The Create Statement of Work screen is displayed.
	

	4
	Select SOW Owner
	In the Create Statement of Work screen, select the SOW Owner from the dropdown list.
If necessary, apply changes to the SOW Billing Currency field and the Billable? field.
	The statement of work may be routed for approval based on the owner selected.
	

	5
	Select Source
	To select a source, choose one of the following options:
1. In the Cards view, select a recently used SOW template, and choose Select.
· In the List view, select a supplier and a SOW template, and choose Continue.
	The Create Statement of Work screen is displayed.
	

	6
	Enter Detail Information
	Enter the required data in all mandatory fields.
In the Posting Information section, enter the following data:
1. Legal Entity. Company Code DE (1010)
· Site: Plant 1 DE (1010)
Note Locations are associated with specific sites. The correct value is automatically displayed in the Location field. There’s no need to change it.
· Business Unit: Purch. Org. 1010 (1010)
In the Cost Allocation section, enter the following data:
1. Cost Center: PFCProject1
Note If the expected cost center doesn’t exist in the list, choose the Add or remove Cost Centers link. In the Add or remove Cost Centers dialog box, check the option Unused. In the Search Cost Centers field, enter the name PFCProject1, and choose Apply Filters. Select the cost center, and choose Add Selected. To return to the Create Statement of Work screen, choose Update.
· General Ledger Account: 65100000
· Task Code: TC
Choose Continue.
	The Clauses screen is displayed.
	

	7
	Skip Clauses Entry
	Clauses are defined as optional in the SOW template. To skip the clauses definition, choose Continue.
	The Characteristics screen is displayed.
	

	8
	Select Characteristics Type
	In the Type fields, select the Events checkbox.
	The Fee Response field is displayed.
	

	9
	Add Event
	Choose Add Event.
Enter the name of the fee (for example: Analysis Deliverables), and enter appropriate data in the Amount field.
Choose Add > Continue .
	The SOW Workers screen is displayed.
	

	10
	Skip SOW Workers Entry
	SOW Workers are defined as optional in the SOW template. To skip the SOW workers definition, choose Continue.
	The Review and Submit screen is displayed.
	

	11
	Submit Statement of Work
	Review the statement of work details on the Review and Submit screen. If necessary, apply changes.
When all data has been reviewed, choose Submit.
	The statement of work is saved, and routed to the next step Pending Approval in the workflow.
Note The statement of work is assigned a unique ID. The ID is located at the top of the page above the title.
	


[bookmark: unique_30][bookmark: _Toc51414344]Approve Statement of Work
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to review the statement of work for accuracy, if necessary apply changes, and approve it.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Approver.
	The statement of work that requires review and approval is displayed in your Work Items menu.
	

	2
	Access Work Item
	From the Work Items menu, select Approve in the Statement of Work section.
	
	

	3
	Approve Statement of Work
	Select the ID of the statement of work, and choose Approve.
Note You can also access the statement of work by selecting Statement of Work from the View menu.
	The statement of work is routed to the next step Pending Response in the workflow.
	


[bookmark: unique_31][bookmark: _Toc51414345]Accept Statement of Work
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to accept the statement of work.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Supplier.
	
	

	2
	Access Statement of Work
	From the View menu, select Statement of Work in the Services section.
Choose the ID of the statement of work desired.
	The Statement of Work screen is displayed.
	

	3
	Accept Statement of Work
	Choose Accept.
	The Create SOW Response screen is displayed.
	

	4
	Review Statement of Work Details
	Review the statement of work details, and choose Continue.
	The Characteristics screen is displayed.
	

	5
	Submit Statement of Work Response
	Choose Submit.
	The statement of work response has been submitted.
The statement of work is routed to the next step Response Pending Approval of the workflow.
	


[bookmark: unique_32][bookmark: _Toc51414346]Mark Work Item as Complete
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to mark a work item as complete.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Supplier.
	
	

	2
	Access SOW Line Item
	From the View menu, select SOW Line Item in the Services section.
Choose the Line Item ID of the event added in the statement of work.
	The Event screen is displayed.
	

	3
	Mark Work Item as Complete
	Choose Mark as Complete.
	The Setup screen is displayed.
	

	4
	Enter Complete Date
	Enter the Complete Date (for example: today), and choose Continue.
	The Review screen is displayed.
	

	5
	Review and Submit
	Review the event details, and choose Submit.
	The event is marked as complete, and routed to next step Pending Approval in the workflow.
	


[bookmark: unique_33][bookmark: _Toc51414347]Approve Transaction
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to review the event for accuracy, if necessary apply changes, and approve the transaction.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Work Item
	In the My Work Items area, select Approve in the Event section.
	
	

	3
	Approve Event
	Choose the ID of the event, and select Approve.
	The Approve Event dialog box is displayed.
	

	4
	Continue Approval of Event
	Fill in the Service Entry Sheet ID, choose Approve.
	The event is approved.
A Service Entry Sheet Request message is sent from the SAP Fieldglass system to the SAP S/4HANA system.
	


[bookmark: unique_34][bookmark: _Toc51414348]Create and Submit SOW Invoice
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to create and submit a SOW invoice for approved completed transactions.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Supplier.
	
	

	2
	Access Create SOW Invoice
	From the Create menu, select SOW Invoice in the Payments section.
	The Create Invoice - Select Statement of Work screen is displayed.
	

	3
	Select Statement of Work
	Choose the ID of a statement of work.
	The Setup screen is displayed.
	

	4
	Enter Invoice Code
	Enter an appropriate Invoice Code, and select the approved Events ID checkbox.
Choose Continue.
	The Details screen is displayed.
	

	5
	Select Adjustment
	In the Adjustments section, select V1 (Invoice) from the dropdown list.
Choose Continue.
	The Review and Submit screen is displayed.
	

	6
	Submit SOW Invoice
	On the Review and Submit screen, review the details, and apply changes if necessary.
Note To save the SOW invoice as a draft, choose Complete Later. You can return to it at a later time for review, completion, and submittal.
When all data has been reviewed, choose Submit.
	The SOW invoice has been created and routed to the next step Pending Approval in the workflow.
	


[bookmark: unique_35][bookmark: _Toc51414349]Approve SOW Invoice
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to approve the SOW invoice.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Approver.
	Invoices that require review and approval are displayed in the My Work Items area.
	

	2
	Access SOW Invoice
	In the My Work Items area, select Approve in the SOW Invoice section.
	
	

	3
	Choose SOW Invoice
	Choose the ID of the SOW invoice desired, and select Approve.
	The Approve SOW Invoice dialog box is displayed.
	

	4
	Approve SOW Invoice
	In the Approve SOW Invoice dialog box, choose Approve.
	An invoice request message is sent from the SAP Fieldglass system to the SAP S/4HANA system.
	


[bookmark: unique_36][bookmark: _Toc51414350]Trigger Transfer of Updated Invoice Status from SAP Fieldglass to SAP S/4HANA
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to trigger the transfer of the updated invoice status from SAP Fieldglass to SAP S/4HANA.
Note If the transfer is already triggered, you can skip this procedure.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP S/4HANA back-end system as Administrator.
	
	

	2
	Access ABAP Editor
	Go to transaction SE38, and navigate to the ABAP Editor: Initial Screen.
	
	

	3
	Choose Program
	In the Program field, enter the value ARBFND_FG_FETCH_CXML_MESSAGES.
	
	

	4
	Run the Program
	To run the program, choose Execute (F8).
	The Fetch cXML Messages from SAP Fieldglass screen is displayed.
	

	5
	Show Log Information
	Choose Execute (F8).
	The Display logs screen is displayed.
The log information with the External ID: InvoiceDetailRequest is displayed.
Note This call gives back the client transaction IDs. To start a second call, and to download the corresponding invoice with the ID of the transferred transaction, repeat step 2 to step 5.
	


[bookmark: unique_37][bookmark: _Toc51414351]Pay Invoice in SAP S/4HANA
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to post outgoing payment for the invoice transferred from SAP Fieldglass to SAP S/4HANA.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fiori launchpad as Accounts Payable Accountant.
	The SAP Fiori launchpad is displayed.
	

	2
	Access App
	Open the Post Outgoing Payments (F1612) app.
	The Post Outgoing Payments screen is displayed.
	

	3
	Enter Payment Data
	In the General Information section, enter the following data:
1. Company Code: <Company Code> (for example) 1010 (DE)
· Posting Date: <today's date>
· Journal Entry Date: <today's date>
· Value Date: <today's date>
· Journal Entry Type: KZ
In the Bank Data section, enter the following data:
1. House Bank/Account: <House Bank> (for example) DEBK1/DEAC1 (DE)
· G/L Account: 11001000
· Amount: <amount to pay on existing invoice>
In the Open Item Selection section, enter the following data:
1. Account Type: Supplier
· Account ID: 10300080
Choose Show Items.
	In the Open Items/Standard section, a list of open items is displayed.
	

	4
	Select Item
	To select the the retrieved invoice to pay, choose Clear.
	The invoice to pay is transferred to the Items to the Cleared (Standard) section.
	

	5
	Post Item
	Choose Post.
	The system message Journal entry xxxxxxxxxx was successfully posted in company code 1010 is displayed.
	

	6
	Confirm
	To confirm the Information dialog box, choose OK.
	
	

	7
	Navigate Back
	Choose Back.
	The system message Journal entry has already been posted. You can now post a new payment. is displayed.
	

	8
	Dismiss Message
	To dismiss the message, choose OK.
	
	


[bookmark: unique_38][bookmark: _Toc51414352]Check Updated Invoice Status
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This procedure describes, how to check the updated invoice status in SAP Fieldglass.
Context
An invoice can have different statuses. The following statuses for an invoice can be displayed in SAP Fieldglass:
1. Approval Paused
· Approved
· Consolidated
· Paid
· Payment Pending
· Payment Review
· Pending Approval
· Pending Consolidation
· Rejected
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log on to the SAP Fieldglass system as Buyer/Administrator.
	
	

	2
	Access Invoice and Display Updated Invoice Status
	From the View menu, select Invoice in the Payments section.
Choose the ID of the invoice desired.
	In the Status column, the updated status of the invoice is displayed.
	




Typographic Conventions
	Type Style
	Description

	Example
	Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

	Example
	Emphasized words or expressions.

	EXAMPLE
	Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.

	Example
	Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.

	Example
	Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.

	<Example>
	Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.

	EXAMPLE
	Keys on the keyboard, for example, F2 or ENTER.
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